A Guide to Using

Vital Rates Analysis Program

Mitchell Taylor ¹
Mirosław Kuc ²
Diana Abraham ³

November 4, 2000

Vital Rates
Population Parameter Analysis Program for Species with Three Year Reproductive Schedules

¹ Wildlife Division, Bag 1000, Station 1170, Department of Sustainable Development, Government of Nunavut, Iqaluit, Nunavut X0A 0H0

² PH 205 – 942 Yonge St., Toronto, Ontario, M4W 3S8

³ ESSA Technologies Ltd. Suite 301, 1595 16th Avenue, Richmond Hill, Ontario, L4B 3N9
# Table of Contents

**INTRODUCTION** ........................................................................................................... 1

General Overview............................................................................................................. 1

Introduction to Vital Rates ............................................................................................... 2

ANURSUS .......................................................................................................................... 2

ANURSUS USER INTERFACE ........................................................................... 9

Introduction to ANURSUS .............................................................................................. 9

Using ANURSUS .............................................................................................................. 9

Main ANURSUS Screen ................................................................................................. 10

ANURSUS Main Menu .................................................................................................... 10

ANURSUS File Menu ...................................................................................................... 10

VITAL RATES ANALYSIS PROGRAM .................................................................. 5

VITAL RATES Main Menu ............................................................................................. 5

VITAL RATES File Menu ............................................................................................... 5

VITAL RATES File Structure ......................................................................................... 5

VITAL RATES Help Menu ............................................................................................. 7

Jump Links ...................................................................................................................... 7

Pop-up Links .................................................................................................................. 7

VITAL RATES Terminology ........................................................................................... 7

BACKGROUND LITERATURE .............................................................................. 4

Abstract from Taylor et al. 1987b .................................................................................. 4

ACKNOWLEDGEMENTS ......................................................................................... 3

System Requirements .................................................................................................. 3

Installation ...................................................................................................................... 3

ANURSUS USER INTERFACE ........................................................................... 9

Introduction to ANURSUS .............................................................................................. 9

Using ANURSUS .............................................................................................................. 9

Main ANURSUS Screen ................................................................................................. 10

ANURSUS Main Menu .................................................................................................... 10

ANURSUS File Menu ...................................................................................................... 10
Table of Contents

A Guide to Using Vital Rates Analysis Program

About Projects ............................................................................................................ 11
File|New Project........................................................................................................... 11
File|Open Project ......................................................................................................... 11
File|Delete Project ....................................................................................................... 12
File|Project Description ............................................................................................. 12
Data Import .................................................................................................................. 12
Import Format .............................................................................................................. 14
About RunIDs .............................................................................................................. 15
File|New RunID ............................................................................................................ 15
File|Open RunID .......................................................................................................... 16
File|Delete RunID ....................................................................................................... 16
Standing Age Datasets ............................................................................................... 16
File|New Dataset(s) ..................................................................................................... 17
File|Open Dataset(s) ................................................................................................... 17
Enter or Edit Standing Age Data ................................................................................ 18
File|Save Dataset(s) .................................................................................................... 18
File|Save Dataset(s) As ............................................................................................... 18
File|Save All Datasets ............................................................................................... 18
File|Close Dataset(s) ................................................................................................ 18
File|Close All Datasets ............................................................................................. 18
File|Delete Dataset(s) ............................................................................................... 19
File|Delete Blank Datasets ....................................................................................... 19
Export Dataset(s) ....................................................................................................... 19
Printing Datasets ........................................................................................................ 21
ANURSUS Pool Function ............................................................................................. 21
ANURSUS Options Menu ............................................................................................ 21
Conducting a Run in ANURSUS ................................................................................ 22
INTERVAL Toggle ....................................................................................................... 23
ANURSUS Help Menu ................................................................................................. 23

INTERVAL USER INTERFACE .................................................................................. 25

Introduction to INTERVAL ......................................................................................... 25

Using INTERVAL ......................................................................................................... 25
Population Parameter Values ....................................................................................... 26
Conducting a Run in INTERVAL .................................................................................. 27
ANURSUS Toggle ......................................................................................................... 27
INTERVAL Help Menu ............................................................................................... 27

INDEX ......................................................................................................................... 29
Introduction

General Overview

Welcome to VITAL RATES, a population analysis system for polar bears and other species with three-year reproductive cycles. The VITAL RATES system consists of two components: ANURSUS and its companion program INTERVAL. These two programs allow calculation of the mean and standard error of population parameters for species with three years of parental care (e.g., polar bears, grizzly bears, and walrus). The parameter definitions and calculation procedures for both ANURSUS and INTERVAL are described in Taylor et al. 1987a and 1987b.

The ANURSUS project was developed as a tool to help create accurate models of polar bear population dynamics. The analysis (ANURSUS) and modeling (RISKMAN) programs were initially developed during a series of workshops co-sponsored by the Canadian Federal-Provincial Polar Bear Technical Committee, the University of Minnesota, and University of British Columbia. The Microsoft Visual Basic programs RISKMAN, ANURSUS, and INTERVAL were translated and augmented from previous mainframe programs by ESSA Technologies Ltd under contract with the Ontario MNR and Nunavut Territory, Department of Sustainable Development. These programs are available free of charge from the Ontario Ministry of Natural Resources home page (http://www.mnr.gov.on.ca/MNR/). The programs and user manual are copyrighted to prevent commercial exploitation, however they may be shared and used freely for research and conservation purposes. Modification of these programs is permitted providing the modifications are also available to all free of charge.

Accurate simulations of species with extended parental care require a correct model (Taylor et al. 1987c), however the degree of bias from using annual (averaged recruitment) models can vary from qualitative to negligible (Testa 1996). INTERVAL calculates annual average recruitment parameters from the more detailed multi-annual parameters. These can be used to compare between populations or used in simpler annual models.
Introduction to Vital Rates

These routines were written for the typical three-year reproduction cycle of polar bears. The reproduction cycle is three years because of extended parental care. Females with cubs and yearlings do not mate, so the reproduction interval when litters are reared and weaned successfully as two-year olds is three years. In nature, cubs and yearlings die, litters are lost, and not all females that are available to mate actually do mate successfully. The result of this rich and relatively complex life history strategy is that the conventional recruitment rate term ($m_x$) is a function of the three year reproduction cycle life history rates, and the underlying age distribution rather than a life history parameter (Taylor et al. 1987a).

Accurate demographic simulations require estimates of the actual life history values except for simulations at stable age distribution (Taylor et al. 1987c). The degree of error can be slight (Testa 1996), however it can also be significant (Taylor et al. 1987c). The severity of the $m_x$ error in a polar bear demographic simulation can only be quantified by comparing an $m_x$ simulation with fully parameterized simulation. For that reason, and when the data are available, a full life history model is recommended for management simulations.

The companion program INTERVAL uses as input the life history estimates from ANURSUS, and calculates the more familiar $m_x$, reproduction interval, and mating interval values for a range of adult annual survival rates. These annual summaries are mainly for comparison with annual rates of annual birth pulse species, but may also give some comfort to new users that the ANURSUS life history parameters are logical and rational. The annual rates may also be exported to annual models for exploratory analyses.

ANURSUS

ANURSUS is an analysis program that develops estimates of population parameters from standing age data. The standing age data are sex/age/family status arrays into which the population members are sorted. When bears are captured, arrays are developed for each year. However, data are not stored as sex/age/family status arrays, but are stored by record. These records can be viewed, modified, or combined. There is also the option to enter the fields of the array if the data are available in that format.

The program is ready to run when the number of arrays and the values in the cells have been determined. A non-parametric statistic built into ANURSUS, called the jack-knife statistic, pools all arrays into a single array, then subtracts the individual year array and calculates parameter estimates with the remaining data. This is done for every year (or combined years) array, producing a number of estimates for each parameter type. The distribution of these estimates allows the calculation of mean and standard error values for each parameter. A separate mean is calculated using all arrays pooled with no subtractions. Both means and the standard error of all parameters are reported.
There are some constraints in the program to keep sparse or missing data from producing impossible results. The ANURSUS calculations are fully described in Taylor et al. (1987b).

**INTERVAL**

The INTERVAL program is a Monte Carlo procedure for estimating the mean and standard error values for the reproductive and breeding interval for polar bears (i.e., a 3-year cycle). The mean and standard error values for the relevant parameters are entered, and the program executes a number of runs using random deviates to produce the mean and standard error values for the interval.

The INTERVAL calculations are fully described in Taylor et al. (1987b).

**System Requirements**

VITAL RATES has been developed to run in a Microsoft Windows 95 environment on a standard PC (486 or greater). It does not require any additional hardware or software beyond that associated with normal operation of Windows 95. VITAL RATES has been coded in Visual Basic, and the interface uses standard conventions and keystrokes for Windows-based applications.

**Installation**

Download the zipped file containing Vital Rates Analysis Program to a temporary folder on your computer and unzip it.

Double click on setup.exe to begin the installation process. Setup will create a Vital Rates folder in your C:\Program Files directory and install the program there unless you specify a different location by choosing the **Change Directory** option.

Following successful installation of the program, the Vital Rates folder will contain a stand-alone Help File called VITALRATES.HLP (double click on it to launch), the application’s executable file (VitalRates.exe), and a subfolder called Data. This subfolder contains a series of dataset files (*.anu) and one sample data file (example.dat).

Archive the downloaded zip file.


**Acknowledgements**

Funding for the work to develop the original algorithms was provided by the Government of the Northwest Territories and the Norsk Polarinstittutt. Funding to translate the programs to Visual Basic was provided by the Government of Nunavut. The upgrade to Visual Basic was in part programmed by Lanlan Cao of ESSA Technologies Ltd.
Background Literature


ANURSUS estimates the mean and standard error of polar bear (Ursus maritimus) population parameters (i.e., cub survival rate, litter survival rate, subadult and adult survival rate, adult mating success, litter size, and mating and reproductive intervals) from age specific observations of litter size and family group status. The parameterization for recruitment estimates is unconventional so that the 3-year reproduction cycle of polar bears may be correctly described.

Previous estimates of annual polar bear cub survival rate considered only the loss of individual cubs; they did not consider abandonment of single cub litters or loss of entire litters. We provide an estimation procedure that accommodates all sources of cub mortality for arctic polar bear populations. Data required for the procedure include: the female age structure; number of females with offspring; presence or absence of cubs-of-the-year, yearlings, or 2-year-olds; and observed litter size.

The average age of first reproduction may be calculated by weighting each age by its probability of first reproduction and determining the weighted average. The probability of first reproduction at age X is determined from age specific litter production rates and the standing age distribution. The average age is for all females in the population during the census period.

The mean interval between producing litters (litter recruitment interval) and the mean interval between mating availability (mating interval) are different for polar bears. The reciprocals of the two intervals, mean litter recruitment rate and mean mating rate, are useful to compare populations but should not be used for population projections. In addition to litter recruitment interval and mating interval, two measures of the expected number of litter recruitment events are also defined.
VITAL RATES Analysis Program

VITAL RATES Main Menu

Launch VITAL RATES to access the main menu bar that provides entry to the system’s two main component programs, ANURSUS and INTERVAL, and to context-sensitive on-line help.

Use the File Menu on the main menu bar to launch ANURSUS or INTERVAL.

VITAL RATES File Menu

ANURSUS User Interface
   File Menu
   Pool Function
   Options Menu
   INTERVAL Toggle
   Help Menu

INTERVAL User Interface
   File Menu
   ANURSUS Toggle
   Help Menu

VITAL RATES File Structure

The program installs to three directories. The first is called Vital Rates. Vital Rates has three subdirectories: ANURSUS, INTERVAL, and DATA. The ANURSUS and INTERVAL subdirectories do not appear until you use the ANURSUS and INTERVAL subroutines. The DATA
directory has an example file so first time users can see how the program works.

The program is designed to allow the user to construct different combinations of years for analysis. The variance is estimated using the jack-knife method with year (or pooled years) as the sample unit. ANURSUS assumes the standing age distribution is representative of the population (i.e., unbiased). Biased or non-representative years should be excluded. The help file describes data entry and data import formats. The files to be imported must be in ASCII comma and quote delimited format as specified in the help file under Find: (Import : Data Import), and (Import: Import Format).

The best way to input data to ANURSUS is to create a single import file. One of the fields is a population identifier, so unlike data from several populations can be pooled into a single master file. The advantage of pooling data is that one only has to go to a single file for all subsequent analyses. ANURSUS analyses require the user to specify a unique project name. As the user identifies the population and which years (and pooled years) will be analyzed, this information is saved under a subdirectory (project-name) under the ANURSUS subdirectory. Work on a given project is kept segregated and saved under the project-name directory. The *.prj file is the project file. The *.anu files are the by-year sex/age/family status files (or pooled files) that are the program input files. The *.anr file is the last result file. Data can also be imported as an individual population and used to construct a project file independently, or appended to the main data file. Adding information from subsequent years is easily done by appending the new data to the main file, and updating the project file. A slower but equally effective third option is to enter the data cell by cell in data entry mode.

The file structure is described in more detail in other sections of the help documentation (see User Interface section). This introduction is provided so that users are aware that they must construct a project file from the data before any analyses are possible. Constructing the set of data files that will be analyzed requires the user to eliminate non-representative (biased) sex/age/family status distributions, and to pool representative but sparse sex/age/family status distributions. The example file has already been "cleaned" and "pooled" as required.

A final tip to ANURSUS users is: one may shift from project to project without saving the current project. The current project is saved and closed automatically when one opens a new project.

The only file retained under INTERVAL are the last results file. The adult female survival rates provided by ANURSUS are actually a fit of a constant decay function $\phi$, to the age distribution. $\phi$ would equal survival rate if the population were at stable age distribution and the population growth rate was 1.0. For that reason the Interval values are given over a range of survival rates. If the adult survival rate is known from other sources, or the population is stable and stationary, then the correct Interval values can be identified (or approximated by interpolation).
VITAL RATES Help Menu

Windows Help offers a quick way to find information, such as how to perform a particular task. Select the Contents and Index option from the Help Menu to access the list of index keywords and search for a particular topic. Alternatively, you can access context-sensitive help for most screens in VITAL RATES by pressing the <F1> function key.

Within a Help topic there may be one or more jump links or pop-up links on which you can click to display additional information about the topics. The mouse pointer changes from an arrow to a pointing finger when it is over a link. Simply click on any link to activate it.

In a button bar at the top of each Help topic window, there is a set of command buttons that provide access to the Help topics browser, the previously selected topic, and other Help options such as printing a topic.

You can also move, resize, maximize, or minimize the Help window, just as you would any other window.

**Jump Links**
Jump links take the user to another, related Help topic. Use the Back command button at the top of the Help window to return to the topic from which you jumped.

**Pop-up Links**
Pop-up links provide additional information about the current topic in a pop-up window that displays on top of the current Help window. Press any key or left-click anywhere on the help screen to close the pop-up window.

VITAL RATES Terminology

- **Cub individual survival rate:** the fraction of cubs (age 0) that survive to age 1 (yearlings) given that the litter survival is 1.0
- **Cub litter survival rate:** the fraction of cub (age 0) litters that are lost as whole litters. This fraction does not include the litters that are lost due to cub individual survival rate
- **Total Cub survival rate:** Cub individual survival rate × Cub litter survival rate
- **Yearling individual survival rate:** the fraction of yearlings (age 0) that survive to age 1 (yearlings) given that the litter survival is 1.0
- **Yearling litter survival rate:** the fraction of yearling (age 0) litters that are lost as whole litters; this fraction does not include the litters that are lost due to Yearling individual survival rate
- **Total Yearling survival rate:** Yearling individual survival rate × Yearling litter survival rate
- **Mating Success:** the fraction of available (females with no cubs and females with two-year olds at age x-1) females that produce cubs at age x; Mating Success is age specific for age 4 and 5 and pooled for age 6+; note Mating Success was called Litter Production Rate in Taylor *et al.* (1987b)
<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Average Age of First Birth:</strong></td>
<td>this is from the standing age distribution and indicated the approximate age of maturity for females</td>
</tr>
<tr>
<td><strong>Adult Survival Rates:</strong></td>
<td>the adult survival rates provided by ANURSUS are actually a fit of a constant decay function $\phi$, to the age distribution; $\phi$ would equal survival rate if the population were at stable age distribution and the population growth rate was 1.0</td>
</tr>
<tr>
<td><strong>Recruitment Interval:</strong></td>
<td>average interval between producing cubs and weaning two year olds for adult females (age 6+)</td>
</tr>
<tr>
<td><strong>Recruitment Rate:</strong></td>
<td>average rate of litter production for adult females (age 6+) ((1/\text{Recruitment Interval}))</td>
</tr>
<tr>
<td><strong>Mating Interval:</strong></td>
<td>average interval between mating for adults females (age 6+)</td>
</tr>
<tr>
<td><strong>Mating Rate:</strong></td>
<td>average rate of mating for adult females (age 6+) ((1/\text{Mating Interval}))</td>
</tr>
</tbody>
</table>
ANURSUS User Interface

Introduction to ANURSUS

This section describes the user interface of ANURSUS and provides an overview of all menu options, commands, and associated functions.

Using ANURSUS

When you first launch ANURSUS, the main screen will display only the Main Menu bar, and the options available from the File Menu will be limited to New Project, Open Project, and Exit. To begin your session with ANURSUS, you must either create a new project or open an existing one. Projects are organizational units that contain all of the standing age dataset files, grouped into one or more RunIDs, on which ANURSUS will base its calculations of population parameters.

If there isn’t already one there, selecting File|New Project will trigger ANURSUS to create a subdirectory in the VITAL RATES program directory called ANURSUS.
Each project is assigned its own folder within this subdirectory, and these contain the dataset files (*.anu), RunID files (*.anr), and project description file (*.prj) associated with the project. All output and export files are automatically saved in the project subdirectory. Once you have opened an existing project or created a new one, and opened or created at least one dataset, the remaining options on the File Menu will become accessible. At this point you will also be able to view all the component parts of the main ANURSUS screen.

**Main ANURSUS Screen**

The main ANURSUS screen is the working core of the program. From here, you can access the options available from the Main Menu bar, see the name of the currently active project, enter/modify RunID names and descriptions, view the list of open standing age datasets, view/edit values in those datasets, and conduct a calculation run.

The components of the main ANURSUS screen are:

- **Main Menu**
  - provides access to file management options, a dataset pooling function, an Options Menu, a toggle to INTERVAL, and a Help Menu

- **Project**
  - displays the name of the active project; cannot be modified

- **RunID**
  - displays user-entered name for current RunID; can be modified

- **RunID Description**
  - displays user-entered descriptive text for additional information about the current RunID; can be modified

- **Dataset**
  - list box that displays the names of all open standing age datasets; can be re-sized to accommodate long dataset names

- **Age and Family Status Categories**
  - data matrix that displays the standing age values for the selected dataset; values can be modified

- **Run**
  - command button that triggers ANURSUS to calculate estimated values for a prescribed set of 14 population parameters, and to generate a report of the results; calculations are based on all open standing age datasets

**ANURSUS Main Menu**

The Main Menu for ANURSUS provides access to file management options, a function that pools data from selected datasets, an Options Menu, access to INTERVAL, and a Help Menu that provides access to context-sensitive on-line help. The Pool Function and Options Menu will only be available when there is an open project.

**ANURSUS File Menu**

Select the File Menu to access the wide range of file and data management options offered by ANURSUS. Use the options on this
menu to create and manage project files, import data, create and manage RunIDs, and to assemble and organize selected standing age datasets for use in calculation runs.

**ABOUT PROJECTS**

Projects are organizational units that contain all of the standing age dataset files, grouped into one or more RunIDs, on which ANURSUS will base its calculations of population parameters. From the **File** Menu, you can create a new project, open an existing project, delete a project, and enter/modify descriptive text for a project.

**File|New Project**

Create a new project by selecting the **File|New Project** option. In the **New Project** dialogue, enter a unique name in the space provided in the **Name** field, and give a description of the project if desired. Following the file naming conventions for Windows 95, you may include numbers and spaces in your project name. There is room for up to 40 characters in the **Name** field, and the name you choose will be displayed in the **Project** field at the top of the main ANURSUS screen.

**File|Open Project**

Selecting the **File|Open Project** option activates the **Open Project** dialogue. Choose a project file from the list of existing projects displayed in the **Project Name** list. All RunIDs associated with the selected project file will be listed in the **RunID** list box. You must select a RunID from this list before ANURSUS will open the project.
The File|Delete Project option allows you to delete the currently active project, the name of which will be displayed in the Project field at the top of the main ANURSUS screen. You will be given the opportunity to confirm or cancel your deletion request.

Use the File|Project Description option to enter/edit descriptive text that provides useful supplementary information about the active project for future reference.

The polar bear data base is a record by record accounting of all the bears that are seen, killed, or captured. For example, if a female with accompanying young (i.e., cubs of the year (COY), yearlings (YRLG), two-year-olds (2YR), or three-year-olds (3YR)) is captured, there is a record for the female, and a record for each of the young bears with her. These individual records must be modified so that accompanying young are listed with their mothers as part of the same record. The record for the females with the young includes information about the age class and
sex of each of her accompanying young. Note that 3YR old accompanying young are treated by the system as 2YR olds.

Independent individuals (i.e., not in the company of a female) of unidentified age (UNID) are considered by the system to be COY. Other data conventions used in Vital Rates include: any individual of unknown sex is considered to be male; and individuals over the age of 24 years are considered to be 24 years of age.

Selecting the **File|Data Import** option activates an *Open* dialogue box. From here, you can browse the file system and select the data file (*.dat, *.csv or *.txt) that contains the datasets with which you wish to work. One data file has been provided with the installation package, and can be found in a folder called Data in the Vital Rates directory.

When you have selected a data file, the *Data Import* dialogue box will appear.

This dialogue lists the *Populations* for which there are datasets in the selected data file. For example, a data file called *POPULATIONS.DAT* contains datasets for five different populations: Baffin Bay (BB), Kane Basin (KB), Lancaster Sound (LS), Viscount Melville Sound (VM), and Norwegian Bay (NB). You can make multiple selections from this list.
by holding the Control key while you left-click on the entries of your choice.

The Data Import dialogue also allows you to select the Record Type you want to import, offering Capture Only, Kill Only, or Capture and Kill. The Record Type you choose will apply to all of the selections you made in the Populations list box. You can work with different combinations of datasets from a single data file by varying your choices in the Populations and Record Type list boxes. To save a combination of datasets, you must assign it a unique RunID (see File|New Run ID below).

ANURSUS imports all selected datasets into the folder of the currently open project, overwriting any previously imported files from the same data file.

The Data Import dialogue also has two options to allow faster handling of data: Load all imported files and Remove blank data sets. The Load all imported files option allows you to automatically load all of the datasets generated from the imported file. This eliminates the necessity to select and load them later. The Remove blank data sets option does not generate the datasets, which would have been empty. This option performs the same function as the Delete Blank Datasets menu option available on the File|Dataset submenu.

You can create your own data files to import into ANURSUS using the File|Data Import option. The system can import *.dat, *.csv or *.txt files, as long as they are in ASCII comma delimited format. The *.csv convention allows users to easily import spreadsheet data (e.g., MS Excel or Corel QuattroPro) into Vital Rates; from the spreadsheet’s Save As dialogue, select the CSV (Comma delimited) format from the Save As Type drop-down list. Import the file into Vital Rates as usual with File|Data Import (see above). Whatever the format you choose, your data must adhere to the following constraints:

**ID:** 6 characters (e.g., D12345)

**Year:** 4 characters (e.g., 1999)

**Month:** 2 characters (e.g., 07)

**Day:** 2 characters (e.g., 15)

**Record Type:** CAP for capture/recapture records, or KILL for all else

**Population:** 2 characters (e.g., BB or VM)

**Sex of Individual:** 1 character (e.g., Male, Female, and Unknown; unknowns are treated by the system as male)

**Age of Individual:** 2 characters (e.g., 05); individuals over the age of 24 years are treated by the system as being 24 years old

**Age Class of Accompanying Young:** NONE, COY, YRLG, 2YR, 3YR, UNID; note that 3YR old accompanying young are treated by the system as 2YR olds
Sex of Accompanying Young: Male, Female, and Unknown; unknowns are treated by the system as male; the system will include only the first three Sex of Accompanying Young values it encounters, e.g., M, M, F, M will be imported as two male and one female; when Age Class = NONE, there will be no values here.

Examples of correctly formatted comma delimited data strings are:

D12345, 1995, 07, 15, CAP, BB, F, 10, YRLG, F, U
K08995, 1995, 04, 17, KILL, BB, M, 00, NONE

➤To import data into the current project:
1. Choose File|Import Data to activate the Open dialogue box.
2. Locate the data file you wish to import, and select it by clicking on the Open command button.
3. This action will activate the Data Import dialogue; from here, choose the datasets you wish to import into the project folder by making one or more selections from the Populations list box and choosing a Record Type.
4. Go to File|Open Dataset and select the dataset(s) with which you wish to work from the project folder.
5. Enter a descriptive name in the RunID field at the top of the main ANURSUS screen to save the selected datasets.

ABOUT RUNIDs

RunIDs are organizational units that contain a user-defined selection of standing age datasets. Create different RunIDs within a project to explore how varying your choice of standing age data influences the outcome of calculations made by the program.

File|New RunID

With the File|New RunID option, you can create a new RunID within the currently active project. Newly created RunIDs are empty and ready to be filled with one or more datasets of your choice. Selecting this option will activate the RunID Name dialogue.

Enter a unique name in the space provided. Following the file naming conventions for Windows 95, you may include numbers and spaces in your RunID name. There is room for up to 50 characters in the text box, and the name you choose will be displayed in the RunID field at the top of the main ANURSUS screen. Use the RunID Description text box at
the top of the screen to enter descriptive text about the datasets in the run.

You can edit RunID names and their descriptions by modifying the text that appears in the RunID and RunID Description text boxes at the top of the main ANURSUS screen. Changing the name of a RunID has the same effect as would a "save as" function. ANURSUS will retain the old RunID, with all its datasets and descriptive text, in the project folder.

**File|Open RunID**

When you select File|Open RunID, the Open RunID dialogue appears.

![Open RunID Dialogue](image)

This dialogue identifies the currently active project in the Project Name field, and lists all of the RunIDs associated with it in the RunID list box below. You can only open one RunID at a time. Select the one with which you wish to work, and click on the OK button.

**File|Delete RunID**

Selecting the File|Delete RunID option removes the currently active RunID from the project. A message will appear, naming the active RunID, and requesting that you either confirm or cancel your deletion request.

**STANDING AGE DATASETS**

The estimates of population parameters calculated by ANURSUS are based on the standing age datasets selected by the user. You can view and modify the values of any open dataset in the Age and Family Status Categories matrix on the main ANURSUS screen. Use the options on the File Menu and Pool Function to assemble, edit, and configure the datasets for each calculation run.

Most dataset file options can operate on multiple datasets. To select multiple contiguous datasets use the mouse pointer to select the beginning of the range of dataset, hold the <Sift> key down and select the end of the data range. To select non-contiguous datasets hold down the <Ctrl> key and select the individual datasets. You can also use the <Shift> and the <Ctrl> keys in combination to select multiple ranges and individual datasets.

The Dataset sub-menu can also be accessed by right-clicking on the list of the loaded datasets.
The File|New Dataset(s) option allows you to create a custom dataset for inclusion in the active RunID. When you choose New Dataset(s) from the File Menu, ANURSUS creates a dataset file called NEW into which you can enter standing age values. Your new dataset file will be listed below the other open datasets in the Dataset list box.

To save your new dataset as part of the active RunID, you must provide a name for it before opening any other RunID. To do this, select File|Save Dataset(s) As and type a unique name for the dataset into the space provided in the Save As dialogue box (see below).

To include additional datasets in the active RunID, select the Open Dataset(s) option from the File Menu. This action will activate the Open dialogue box which displays all of the datasets currently available to you in the project folder. All datasets associated with the active RunID are listed in the Dataset list box on the main ANURSUS screen. You can increase the width of this box with the mouse to show longer dataset names as required.

It is important to remember that the datasets in your project folder reflect the population and record type choices you made when you imported them (see File|Data Import). If you want to access datasets with different import parameters, you can do so by browsing through other project folders and opening selected datasets from there. Dataset files selected in this way will be copied into the active project folder, overwriting existing files with the same name (but not necessarily the same data). Alternatively, you can use the Data Import option from the File Menu to import new datasets into the active project folder. Be aware, however, that changes made to datasets in the active project will be reflected in any RunIDs that contain links to those dataset files. For example, if you replace a dataset called 1997_bbls.anu with another...
dataset of the same name but different import parameters (and data), any RunIDs linked to 1997_bbls.anu will now contain the new dataset file.

Enter standing age data by typing values directly into the cells of the *Age and Family Status Categories* matrix. You can enter the same value into 2 or more adjacent cells by using the blocking feature. Left-click on one of the corner cells of the block and right-click the opposite corner.

The cells of the selected block will be displayed in cyan, and a pop-up menu will appear that shows the available actions. These are:

**Enter Value**
activates a dialogue box into which you type the value you want to enter into each cell of the block

**Clear**
resets all cells in the block to 0

**Exit Without Action**
leaves the *Available Operations* screen without making any changes; you can also press the Esc key to exit from this screen

To re-define an existing block, right-click on the new corner cell. To unblock, simply left-click on any cell in the matrix.

Use the **File|Save Dataset(s)** option to save the changes you make to the currently selected dataset.

Use the **File|Save Dataset(s) As** option to save the currently selected dataset under a new name. **Save Dataset(s) As** will retain the original dataset and its values in the project folder.

Use the **File|Save All Datasets** option to save the changes you have made to all open datasets in the current RunID.

Use the **File|Close Dataset(s)** option to remove the selected dataset from the *Dataset* list box of the current RunID, but not from the project folder. With this feature you can selectively remove datasets from an existing RunID, without losing access to them for use in another RunID or project.

Select the **File|Close All Datasets** option to remove all datasets from the *Dataset* list box of the current RunID, but not from the project folder. Use this feature of ANURSUS when you want to create an entirely new
list of datasets for a particular RunID, but wish to retain the originals for use in another RunID or project.

**File|Delete Dataset(s)**

The **File|Delete Dataset(s)** option removes the selected dataset from the project folder. Deleted dataset files are no longer available for use in other RunIDs or projects.

**File|Delete Blank Datasets**

The **File|Delete Blank Datasets** option removes all of the datasets that do not have individuals in any of the age/sex/family status categories.

The system scans all of the loaded datasets and lists ones that are detected to be empty. You can remove them by pressing the *Remove* key or exit the screen without removing any datasets by pressing the *Cancel* key.

 Optionally you can remove the blank datasets from the project directory by selecting the *Delete from Disk* option.

**EXPORT DATASET(S)**
The Vital Rates program can export the datasets in 3 formats: *As CSV File(s), As RISKMAN Population File(s) and As RISKMAN Hunt Data File(s).*

For population and hunt data export into RISKMAN you will have an opportunity to specify the dimensions of the output file. The dimensions default to the size of Vital Rates dataset (25 age classes and the maximum of 3 offspring). You will have an option to change the standard number of age classes to be exported and the maximum number of offspring included in the file. If there are fewer age classes requested for the export file the extra age classes are ignored. If the maximum number of offspring is specified as less than 3, the number of females with the extra offspring are pooled into the family category with the highest number of offspring. If the size of the export array is larger, the additional values are set to zero. For example if the export array size was set to 2 cub litters with a maximum age of 30, all females with three cubs would be listed as females with two cubs, and all age classes > 24 would be 0.

If you select any of the 3 export functions you will have an asked to enter the file name and the location for the exported data. By default the export files name will be the same as the dataset name with the appropriate extension.
**PRINTING DATASETS**

The Vital Rates system has two print options. You can select and print a subset of the loaded datasets using the *Print Current Dataset(s)* or print them all with *Print All Datasets*.

**ANURSUS POOL FUNCTION**

When populations are determined to have the same vital rates, they can be pooled and re-analyzed to increase the sample size. Use the *Pool* Function on the *Main* Menu to create dataset files that combine the values in selected datasets into a single, new dataset. The *Pooling Data* dialogue opens when you select this option.

Choose two or more datasets from the *Select Dataset* list box, and provide a unique name for the new, pooled dataset. You can select contiguous datasets by selecting the first dataset in the range, then holding the *<Shift>* key selecting the last dataset in the range. You can select non-contiguous datasets by holding the *<Ctrl>* key while you left-click on the file names of your choice. You can use the *<Shift>* and the *<Ctrl>* key in combination to select multiple ranges or individual datasets.

Pooling adds the values in the *Age and Family Status Categories* matrix from multiple datasets to create a single, combined dataset. The component dataset files are automatically closed and replaced in the *Dataset* list box with the new, combined dataset file.

You can use the *Delete Constituent Dataset from Disk* option to remove the datasets used to form the new pooled dataset. This option can be used to insure that a given data set is not accidentally included twice in a given analysis. However, the user may also use the name of the pooled dataset to identify the datasets that were included. The user always specifies the active datasets for any given analysis, so the *Delete Constituent Dataset from Disk* option is not required for a correct analysis.

**ANURSUS OPTIONS MENU**

Use the *Options* Menu to specify minimum age values for use in male and female survival rate calculations. Selecting *Options* from the menu bar opens the *Options* dialogue.
The values you enter here identify the first age class (minimum 0) to be used in the Chapman-Robson truncated estimate of the constant survival rate for adults (males and females). The default value of 5 signifies that individuals in age class 4+ are used in the estimate.

On the **Options** screen you can also specify how you wish to view the results. Selecting a *Text* view displays the results as a text file in the Notepad built into the MS Windows operating system. Selecting the *Spreadsheet* view allows you to view the results as a CSV file in a spreadsheet. You will have to specify an application you wish to browse the output with (e.g. MS Excel).

One thing to remember is that while the Notepad allows old copies of the results file to be visible, the spreadsheets usually don’t. You will have to close the results file before running the system again.

When you have finished assembling and modifying the datasets in a particular RunID, setting options, and pooling datasets as required, you are ready to conduct a run of the model.

The **Run** command button, located below the **Dataset** list box on the main ANURSUS screen, triggers the system to calculate estimated values for a prescribed set of 14 population parameters, and to generate a report of the results. The report includes summary statistics and a correlation matrix of 14 rows and 14 columns of values, one for each population parameter in the run. Calculations are based on all open standing age datasets in the currently active project.

The population parameters, with the acronyms that appear in the correlation matrix, are:

- Adult Female Survival Rate (S/L)
- Mean COY Litter Size (CLS)
- Mean Yearling Litter Size (YLS)
- Mean 2-Year-Old Litter Size (TCS)
- COY Survival..1-Cub Litter (S1)
- COY Survival..2-Cub Litter (S2)
- Yearling Survival Rate (YSR)
- COY Litter Survival Rate (CLSR)
- Yearling Litter Survival Rate (YLSR)
- Mating Success 4-Year (PHC4)
- Mating Success 5-Year (PHC5)
- Adult Mating Success (LPROD)
- Average Age of First Birth (AAFB)
- Adult Male Survival Rate (S/L-M)
Note that in most cases COY litter survival for one cub litters (S1) equals COY litter survival for two cub litters (S2).

Select INTERVAL from the menu bar to toggle over to the INTERVAL component of VITAL RATES. For more information about INTERVAL, see the INTERVAL User Interface section below.

On-line Help is available from the ANURSUS Main Menu bar. Windows Help offers a quick way to find information, such as how to perform a particular task. Select the Contents and Index option from the Help Menu to access the list of index keywords and search for a particular topic. Alternatively, you can access context-sensitive on-line help about any of the screens in ANURSUS with the <F1> function key.
Introduction to INTERVAL

This section of the help documentation describes the user interface for INTERVAL and provides an overview of all menu options, commands, and associated functions.

When you select INTERVAL from the VITAL RATES Main Menu, or toggle to it from ANURSUS, you will see the INTERVAL Main Menu bar and the program's main component - the Population Parameter Values screen. The Main Menu bar offers a File Menu from which you can Exit from VITAL RATES, an option to toggle over to ANURSUS, and a Help Menu for access to on-line help.

Using INTERVAL

In most birth-pulse populations, mature females can produce young every year. The per capita recruitment term, \( m_x \), is typically the number of female young produced per female in a given year. In models where both sexes are considered, \( m_x \) can be the number of young produced per female per year. For species with extended parental care (e.g., polar bears), \( m_x \) is an abstraction. Annual models that use \( m_x \) are accurate only when the population sex, age, and family status distribution does not change over time. For stochastic or dynamic models that are not at stable age distribution, have selective harvesting, or selective density effects; the changes the sex/age/family status structure causes errors when \( m_x \) is used for species with 2 or 3 year reproductive cycles.

However, in many cases the errors are small relative to measurement error, or when the dynamics do not cause the sex/age/family status distribution to change much. There are many useful models that cannot accommodate the parameters from a multi-year reproduction cycle life history. These require an estimate of \( m_x \). Finally, for comparison to
other species with annual life history schedules, it is useful to have an estimate of \( m_x \).

INTERVAL makes use the relationship between reproductive interval and reproductive rate: Reproductive Rate = \( 1/\text{Reproductive Interval} \). By estimating the reproduction interval from the ANURSUS parameters, one also estimates reproduction rate.

The estimate of \( m_x \) for young per female is: \((\text{COY litter size}) \times \text{reproduction rate}\).

The other parameters are mainly for comparison between populations, and because they provide some insight to the consequences of a multi-year reproduction cycle.

The option *Print results of calculations on a range of adult survival rates* allows you to choose whether you wish to view the results of a single value of adult female survival rate, or a range of the values.

If a range of values is selected, the estimates are calculated for a range of annual adult survival rates from 1.00 to 0.81 (increments of 0.01) because adult survival is sometimes not known. The specified survival rate is always included in the order that it occurs within the range given.

INTERVAL offers users the opportunity to explore the effects of different *Population Parameter Values*, such as litter size and individual survival rate, on reproductive and breeding interval values for polar bears.

Identify each set of values you enter with a unique *Run Identification* name and *Description*, both of which will appear at the top of the run results report generated by the program. Enter mean and standard deviation values for each of the five population parameters listed by typing them into the text boxes provided. Be careful to use numbers that range between 0 and 1 for each of the rate-based parameters.
The option *Print results of calculations on a range of adult survival rates* allows you to choose if you wish to view the results of a single value of adult female survival rate or a range of the values.

The estimates are calculated for a range of annual adult survival rates from 1.00 to 0.81 (increments of 0.01) because adult survival is sometimes not known. The specified survival rate is always included in the order that it occurs within the range given.

When you have entered a complete set of population parameter values, click on the **Run** command button at the bottom of the screen. This action triggers INTERVAL to calculate mean, standard deviation, and standard error values for a prescribed set of six reproductive parameters based on the values you entered. At your option these calculations can be repeated for adult survival rates ranging from a maximum of 100% down to a minimum of 81% or on a single value you have entered in the *Adult Female Survival Rate*. The results report generated by INTERVAL is displayed in Notepad, and can be printed or saved to a file from there.

Select ANURSUS from the menu bar to toggle over to the ANURSUS component of VITAL RATES. For more information about ANURSUS, see the ANURSUS User Interface section above.

On-line Help is available from the INTERVAL **Main Menu** bar. Windows Help offers a quick way to find information, such as how to perform a particular task. Select the **Contents and Index** option from the **Help Menu** to access the list of index keywords and search for a particular topic. Alternatively, you can go directly to help information about the screen in INTERVAL by pressing the <F1> function key.
# Index

## A

- **ANURSUS 2**
  - conduct a calculation run 22
- File Menu 11
- functional overview 9
- general overview 1
- Help Menu 23
- Main Menu 11
- main screen components 10
- Options Menu 22
- pool function 21
- run results report 22

## D

- **Data Import**
  - import format 14
  - import parameters 13
  - import procedure 15

## F

- **File Management in ANURSUS 11**
- File Menu
  - about importing data 13
  - about project files 9, 11
  - about RunIDs 15
  - about standing age datasets 17

## I

- **INTERVAL 3**
  - conduct a calculation run 26
  - general overview 1
- Help Menu 26
- population parameter values 25
- run results report 26

## J

- **JACK-KNIFE Statistic 2**

## O

- **Options Menu**
  - about setting options 22

## P

- **Pool Function**
  - about pooling standing age datasets 21
- **Population Parameter Values**
  - about entering 25
- **Project**
  - create a new project 11
  - delete an existing project 12
  - description 12
  - file management 9, 11
  - open an existing project 12

## R

- **Results Report**
  - **ANURSUS 22**
  - **INTERVAL 26**
- **Run**
  - about conducting a calculation run in ANURSUS 22
  - about conducting a calculation run in INTERVAL 26
  - about population parameters used in ANURSUS 22
  - reproductive parameters used in INTERVAL 26
  - results report in ANURSUS 22
  - results report in INTERVAL 26
- **RunID**
  - create a new RunID 16
  - delete an existing RunID 16
  - file management 15
  - open an existing RunID 16

## S

- **Standing Age Datasets**
  - close all open datasets 19
  - close the active dataset 19
  - create a new dataset 17
  - delete an existing dataset 19
  - enter or edit standing age data 18
  - file management 17
  - open an existing dataset 17
  - save a dataset 18
save a dataset under a new name
19
save all datasets 19

V

VITAL RATES
File Menu 5
general overview 1
Help Menu 7
Main Menu 5